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1 BASIC PRINCIPLES 
Use of the ccAssembler is kept as easy and intuitive as possible. An understanding of a few basic 

principles is sufficient to experiment and obtain your first results. 

1.1 INSTALLING ANCHOR ON ANCHOR 
A special property of the program is that the actual geometry of the parts is of secondary 

significance for most of the actions. The use is instead concentrated more on the snap points 

defined in the parts, which are also called anchors. They play a decisive role especially when 

positioning parts in the assembly. In the majority of cases a part to be installed (referred to in 

the following as "insert" for short) is attached to an already positioned part (referred to in the 

following as "attachment" for short).  To this end, an anchor is defined in both the insert and 

in the attachment and the new part is inserted so that the two anchors are congruent. 

Rotation about this point is defined afterwards, but often the suggested orientation is the most 

sensible. This is because the anchors are preferably installed in opposite directions to each 

other, i.e. "tip to tip" (provided the parts logic does not insert additional rotations, but more on 

that later).  

The so-called "line anchors" play a special role; these not only represent a specific position, but 

also an arbitrary position on a line (e.g. along a groove). The precise position can be 

determined either by orientating it on the distance from the end points or as a percentage 

lambda value (e.g. 50% for the middle point between the end points). 

The anchors are not only used for the insertion of parts but also as reference points, e.g. for 

measuring or as the centre for rotations. 

1.2 MODES AND ACTIONS 
The main user actions take place via the program's Main window. By choosing a command (in 

the menu or context menu), this main window is placed in a corresponding mode, which 

defines a sequence of actions. 

The current action in turn determines the consequences that a 

mouse movement, mouse click or pressing a key have. The 
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currently active mode and the current action are always displayed at the top in the 

Control window. 

For example, if you want to rotate and already positioned part, select the "Rotate" command 

from the menu in order to activate Rotation mode. If a part has not yet been selected, in this 

mode the action "Select Part" is set first. The part to be rotated can then be selected with a click, 

after which the next action to be set is the selection of the centre of rotation. Actions for selecting 

the axis and for defining the angle follow. Following completion of the last action the mode is 

ended and the program returns to selection mode. There are also modes, which do not end 

automatically, but remain active until you select another mode. This is described in detail further 

below. 

It should be noted that cancelling an action often does not cancel the whole command. Instead, 

the program jumps back to a preceding action, e.g. to select another centre of rotation without 

having to reselect the parts concerned. 

1.3 MOUSE CONTROL AND DIRECT INPUT 
One of the biggest advantages of the ccAssembler is the ability to handle a large part of the user 

actions using the mouse without having to enter numerical values with the keyboard. 

Nevertheless, in several situations it is easier to enter a value directly, e.g. if you want to select 

a specific position on a line anchor. This can be done via the Control window. In order to 

avoid conflicts with the mouse movement, with most actions it is possible to switch the mouse 

control on and off using the Backspace key. In the Control window, the increment for the 

mouse control can often also be defined. 

The idea of making functions available not only via the mouse but also via the keyboard is 

continued in that on the right-hand side of the Main window, depending on the current action, 

buttons can be displayed, which partly serve as alternatives to keyboard commands. For 

example, one of these buttons enables the user to switch between local and global coordinates, 

which can also be performed using the space bar. 

1.4 EDITING SEVERAL DOCUMENTS SIMULTANEOUSLY 
In ccAssembler it is possible for several documents to 

be open at the same time. This is shown by the 

different colored tabs at the top edge of the Main 

window. Here it is also possible to switch between 

the documents. The current document is closed by 

clicking the "X" in the right of the tab. 
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Project/Library window 

2 THE WINDOWS 
The user interface of the ccAssembler enables the individual windows to be ordered any way 

the user wants and to change their size. The starting position can be restored at any time 

using the menu command "Options  View  Reset Window".  

  

  

Apart from the Options menu, it is also possible to switch to 

Catalogue Mode (or back). In this case the Main and Control 

windows and the menu are hidden and the remaining windows are rearranged. This display is 

particularly suitable if you only want to 

see parts and to compile a bill of materials 

without specifically installing them. 

The individual windows are briefly 

explained in the following. 

2.1 MAIN WINDOW 

Main window Control window 

 

Preview window/Info Library list, Bill of Material & Log 

window 
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The main window represents the current assembly and forms the centre for most of the 

interaction. The significance of mouse clicks and keys varies depending on the mode selected 

and the current action. In general, however, the left-hand mouse button is used for 

interaction, the middle mouse button is used to change the view and the right-hand mouse 

button is used to open the Context menu (or the Gesture Control, see below). 

The Main window usually displays the global coordinate system as lines, which originate from 

the zero point. Continuous lines stand for positive axes and broken lines for negative axes. 

However, this display of the coordinate system is adjusted by many actions. For example, it often 

jumps from the global zero point to the reference point of an action and is possibly rotated so 

that it corresponds to the local coordinates of a selected part. 

An additional coordinate system in the bottom left-hand corner of the window on the other 

hand always remains oriented according to the global coordinates. This display also enables 

adjustment of the view using the left mouse button. If this button is clicked and the mouse is 

dragged at the same time, the view is rotated or if the Shift key is pressed and kept pressed 

it is moved. Individual clicks on the axes select the fixed views from above, the front, right, etc. 

(please note: Near this coordinate system, conflicts with the current action of a command can 

occur due to the use of the left-hand mouse button) 

The "View" menu can also be used to show a grid in the x-y plane  in the Main window, 

which is used for orientation purposes. Its 

dimensions can be defined using the Options (see 

below). In addition, this grid can also be used as 

the floor slab. If the relevant function  is activated, 

an anchor is positioned in each of the places where 

lines cross at which parts can be attached (or which 

can be used as reference points). An activated floor 

slab can also be selected, moved and rotated like 

a normal part. 

In addition, a display of the floor  can be activated, which always extends, regardless of the 

grid size, so that the current assembly (including zero point) is covered. 

2.2 CONTROL WINDOW 
This window fulfils the important function of always 

displaying the active mode and the current action. 

In addition, the current interaction options via the 

mouse and keyboard are listed. Here it is therefore 

possible to tell at a glance what is being done, what has 

to be done or can be done. The window also provides 

several interaction options in that, primarily, 

numerical values can be entered and changed 

directly or actions such as the snapping of target points 
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(anchors) can be switched on and off. 

2.3 LIBRARY AND LIBRARY LIST 
These two windows are used to display the product catalogue and for selection of the parts 

to be installed. 

The library window represents the different product 

groups in the form of a tree. A group can be selected 

here, so that it is opened in the library list. 

The library list lists the products contained in a 

product group (and possibly their subgroups) together 

with some information and a preview image. A specific 

part, e.g. for inserting, is then also selected here. The 

corresponding button in the entry can also be used to export a part individually (with the 

degree of detail given in the toolbar). The procedure and options are identical to the 

export of the whole assembly described later. A list entry can also be dragged into the Main 

window by means of Drag&Drop to insert the relevant part directly. Alternatively, it is possible 

to include the selected part in the bill of materials without positioning it in the space. The 

corresponding button  of the Toolbar can be used for this. It is also possible to insert a part as 

a sub-part of an already installed part, by dragging the list entry by means of Drag&Drop to the 

relevant entry in the Project window. 

In the Toolbar it is also possible to open an Information window with information on the 

currently selected part. Here there is also the "Configurations" function which, if applicable, 

opens the Configuration window for a selected part (see below). The "Refresh Selection" 

button is used for a substitute to re-selecting a part in the Library list of the Library tree that has 

already been selected by clicking it again. In addition, Previews can be shown and hidden in 

the Toolbar. 

The Search function of the list is described later in this document, in a separate chapter. 

2.4 PREVIEW WINDOW 
The Preview window displays the part selected in the 

Library list and if applicable, enables selection of the 

anchor to be used for the insertion. If you keep the Shift 

key pressed here while moving the mouse, the part is 

displayed transparently, which also makes it easier to 

select anchors concealed by the geometry.  The view can 

also be changed here using the mouse or Toolbar, which is 

also the case in the Main window. It is possible to use Drag&Drop to drag the displayed part 

from this window into the Main window in order to insert the part there. 
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2.5 PROJECT WINDOW 
The Project window contains a tree structure in which 

there is an entry for each instance of a part contained in 

the current assembly. If such an entry is selected the 

corresponding part in the Main window is also selected 

and vice versa.  For easier orientation it is also possible to 

give each of the individual installed instances their own 

name by editing the entry. This is then also used in the 

bill of materials and is displayed in the Control window, if the part is selected in "Select mode“. 

One or several comments  can also be attached to a selected part. These also appear in the bill 

of material as additional rows under the relevant entry. Parts which have been inserted via the 

Library list and which are not represented in the Main window are colored grey and can be 

deleted here  or if necessary edited . If a part has sub parts, it is marked with a + symbol . 

The sub parts of the selected part can be edited using the  button. 

In addition, instances can be grouped here, which is described in greater detail later in the 

relevant chapter. 

2.6 BILL OF MATERIAL (BOM) 
A continuously up-to-date bill of material is displayed here 

and can also be output. This is described in greater detail 

in the relevant chapter later in the document. 

2.7 INFO 
Info on the part currently selected in the library is 

displayed here (if available). 
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3 CAMERA AND VIEW 

3.1 MOUSE CONTROL 
The middle mouse button is reserved for 

changing the view in the Main and Preview 

window. By default, holding the button causes 

a rotation in the form of orbiting of the 

camera around the scene. If the Ctrl key is 

pressed at the same time, a relative orbit 

about the clicked point is selected. (Note: It is 

advisable to experiment with these two 

rotation options so that you develop an intuition for them, as it is difficult to describe the 

behavior). In addition, the scene (or camera) can also be moved, by keeping the Shift key 

pressed. The mouse wheel is used to zoom. Here you should note that the position of the mouse 

pointer is important (not only when zooming in but also when zooming out). 

As already mentioned in the description of the Main window, it is also possible to use the left 

mouse button to change the view if you are using the coordinate system in the bottom left-

hand corner. In addition, you can use the "Display" menu to select the Zoom, Move and 

Rotate View modes. These replace the previously active command and enable the 

respective change with the left mouse button to be made anywhere in the window (useful, 

e.g. if the mouse does not have a middle button or wheel). "Zoom Window " mode can 

also be selected as a sub-point of the Zoom function; in this case, the mouse is used to drag a 

window, which defines the required detail section of the image. A further sub-point here is 

"Zoom all" in which the zoom level is adjusted without changing the rotation so that the entire 

assembly can be seen. 

The menu also provides the option of quickly switching to default views (from 

above, underneath, left, right, front and rear or isometric view). Here too the 

detail window is chosen so that the complete assembly can be seen. 

Middle mouse button  Rotate view 

Middle button + Ctrl Relative rotation 

Middle button + Shift Move view 

Mouse wheel Zoom 

 



 

www.cadclick.de - 13 - © KiM GmbH 

4 BASIC MODES 

4.1 SELECTION 

4.1.1 SELECT  
Use this mode to select already installed instances. A multiple selection can be made by 

dragging a frame. In general, only parts located completely in the frame are selected. To select 

the parts which are only partly within the frame too, you must drag the frame from the bottom 

right hand side to the top left hand side (can be recognized by the violet color of the frame). In 

addition, after selecting the first part, further parts can be added by keeping the Ctrl key 

pressed. Equally, parts can also be deselected. If the Ctrl key is pressed it is also possible to add 

several parts to the selection by dragging a frame. 

In this mode it is also possible to define that the selected parts are to be displayed 

permanently transparent (by pressing the T key or the button in the Main window). These 

parts can then no longer be selected in other modes. Therefore, instead it is possible to select 

concealed geometry "through the parts", which can be very useful, e.g. for plates or slabs. 

However, in this selection mode the relevant parts continue to be selectable, so that the 

transparency can also be switched off again. It is also possible to use the Control window to 

reset the transparency for all parts. 

In this mode (depending on the setting in the Control window), handles or interactive anchor 

can be displayed on the selected part, with which parts can be quickly edited or inserted 

without changing the mode. This is described in greater detail in a separate chapter later in the 

document. 

4.1.2 SELECT AND SEARCH  
In this mode, individual parts are selected (no multiple selection). Unlike the normal Selection 

mode, the selected part is additionally selected in the library (and therefore also in the 

preview window) as an insert, so that further copies of this part can be installed. 

4.1.3 SEARCH FOR FITTING PARTS  
Here not only a part but also one of the anchors is selected. A search for all parts that can be 

attached at this anchor is then started in the Library list (see Parts Logic chapter further 

below). The anchor selection also continues to apply as a preselection for possible subsequent 

opening of the Insert function. If this is started, the new part is attached directly to the 

previously selected anchor without having to re-select it. 

4.2 INSERT  
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If this mode is activated, depending on the part to be inserted, in general the program 

automatically switches to one of the easy to use modes: "Quick Insert", "Insert on Groove" or 

"Insert Area". However, exotic insert options could possibly not be fully covered by these modes, 

which is why it is always possible to use the "Switch to detailed insert mode" 

button in the Main window to return to the basic Insert mode described here.   

In this mode the part displayed in the Preview window can be inserted in the assembly. While 

the insert anchor is already selected in the Preview, the attachment anchor on which it is to 

be placed should be selected in the Main window. If you move the mouse pointer across the 

screen the parts are automatically selected (marked) and their anchors are displayed. As in the 

Preview, parts selected here are displayed transparently, if you keep the Shift key pressed 

while moving the mouse. If you pause on an anchor for a short time with the mouse pointer, the 

transparent Preview changes from violet to orange and is rotated in the same way as the part 

will probably be inserted. The Rotation Suggestion is produced by the fact that in general 

anchors are installed in the opposite direction, i.e. are installed tip to tip. Click the anchor to 

confirm the insert position. 

You can then define the rotation. Following a direct input in the Control window, this is also 

possible in 90° steps with the mouse. You can select all directions along the main axes, either 

of the global or of the local coordinate system (local with regard to the part to which you attach 

the part). You can switch between global and local by pressing the Space bar. However, you 

cannot use the mouse position to define every possible rotation. The remaining degrees of 

freedom are covered in the form of a rotation about the part's own axis with the help of the 

Tab key. Alternatively, the Cursor keys and Page Up/Down can be used to rotate in 

previously defined (in the Control window) steps. 

In addition, it is also possible to add an offset to the Insert Position by entering the relevant 

values in the Control window. The offset can also be defined with the help of the mouse if you 

use the mouse control (with the Backspace key or in the Control window) to switch to "Offset". 

Several parts also have a variable length, which can also be defined during the Insert action. 

This is possible using the mouse position (in an increment defined in the Control window) as 

well as by entering the numerical value in the Control window. The numerical value can also 

be entered directly in the Main window (Backspace is then used to Reset). Another option is 

to automatically adjust the length to a target point. To do this, the mouse pointer must 

merely be positioned above the relevant target anchor. If the rotation is not in the required 

direction it is also possible to "fix" the current mouse rotation by keeping the Ctrl key pressed. 

In this case, only the length changes, but not the orientation. In the Control window you can 

deactivate snapping of target points, if it interferes with the current insertion. 

It must be noted that if several instances of the same part are to be inserted consecutively, the 

rotation and length used are saved so that the other parts can be quickly inserted in the same 

way. After choosing the insert position the program tries to adjust the rotation and the length 

so that they correspond to the previous insertion of the part. This suggestion can be 
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accepted by using the Enter key for the anchor selection and confirmation of the insertion or by 

clicking without moving the mouse pointer. If you want to prevent this adjustment (and instead 

see the usual suggestion based on the anchor information) it is sufficient to re-select the insert 

anchor in the Preview before the part is inserted again. 

In this mode it is also possible to attach a part, not to an existing part, but freely on the floor (of 

the x-y plane) by clicking in the Main window, outside the snap range of anchors, when selecting 

the attachment anchor. This option is illustrated by the fact that if the mouse pointer is paused 

the Preview changes from violet to yellow and is rotated / positioned accordingly. 

4.3 Quick Insert  
This mode is an alternative to the normal Insert mode, in which logic definitions are used to 

attempt to limit the selection to the most sensible insert options. An important difference here is 

also the fact that it is not necessary to select a useful insert anchor in the Preview window first. 

Instead, only the attachment anchor in the assembly is selected. Based on this selection a 

suitable anchor is then automatically defined in the part to be inserted. If there are several 

possible anchors, it is possible to switch through these until the required one is active. To do 

this, the mouse control must be switched to "Change Anchor" mode (use button in the Main 

window or press the Backspace key) and then the mouse cursor moved to the left or right. The 

change is illustrated by the fact that only the relevant anchor can be seen in the Preview 

window. In the "Rotate around anchor" mouse mode it is also possible to rotate the part to be 

inserted in the attachment point about its Z axis (also done by moving the mouse pointer to the 

left or right). Regardless of the mouse control, the Space bar can also be used to change the 

anchor or the Tab key can be used to rotate it. Here it must be noted that only the rotation about 

the z axis can be changed while the remaining rotation is defined automatically. The basic 

principle of installing the anchors tip to tip is possibly not pursued further here, if another 

rotation makes more sense. 

If the required insertion has been confirmed with a click, the length of the part can then be 

defined, providing it is variable. If the attachment anchor selected at the beginning is a line 

anchor, in a following step it is possible to define the insert position on it. As with normal insert, 

numerical values for length and position can also be entered here in the Control window. There 

it is also possible, as usual, to activate snapping of anchors (target points) for fast definition of 

the values using the mouse. In this case, snapping to anchors can be used particularly effectively, 

in order to build several parts at the same height in different grooves. 

Quick Insert mode is particularly suitable for inserting parts with many different anchors, 

especially profiles. However, the insert variants are limited to the most important, so that the 

Insert mode described in detail above must be used for more unusual variants (to be opened via 

the corresponding button in the Main window). 

4.4 Insert on groove  
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Several parts with variable length, e.g. seals are almost always installed in a groove. This can 

easily be done using the normal Insert mode, however, it is made even easier with the help of 

this special mode. Similar to Quick Insert, in this case, instead of selecting an insert anchor in the 

Preview you initially only select the required groove. You then select the start and end point on 

the groove for the part to be inserted. It is also possible to choose points on the extension of the 

groove. The positions can also be given in the Control window by entering the distance to the 

end points of the groove or as a percentage on the groove. Negative distance values to the 

nearest end point apply to positions on the extension of the groove, or lambda values <0% or 

>100%. Example: 

 

When selecting the end point, instead of defining the position you can define the required length 

of the inserted part instead(orientation as last indicated with the mouse). 

After defining the start and end point, in a final step it is also possible to choose the insertion 

direction, which can be decisive for parts that do not have a symmetrical cross-section. Here it 

must be noted that in this mode you cannot define any rotations, as these automatically result 

from the insertion along the groove and the insertion direction. 

4.5 INSERT AREA PART  
Area parts, i.e. parts whose length and width (and partly the thickness too) are variable can also 

be inserted using the detailed Insert mode; in which case the length and width can be 

selected via the Control window. However, it is more useful to use this special Insert mode, 

in which the area is defined by selecting 3 corner points. The triangle formed in this way must 

result in a right angle. The mouse control can be switched off using the Backspace key in order 

to select precise positions on the line anchors. 

 After choosing the third point it is still possible to edit the edges of the area by gripping them 

near the Letter marking with the mouse and moving them as required (in which case, the 

program automatically jumps to anchors near the mouse pointer, if it was not deactivated 

beforehand in the control). Alternatively, you can also enter numerical values in the Control 

window to move inwards or outwards. In this case the edges are individually identified and 

addressed via letters and color markings, but you can also enter a value, which is added to each 

of the 4 edges. It is also possible to enter an Offset in the insert height, and to rotate the plate 

(the thickness then stretches or extends in the opposite direction). 



 

www.cadclick.de - 17 - © KiM GmbH 

4.6 INSERT AREA PART WITH FASTENERS  
In this mode, not only an area part is inserted, but also the parts required to fasten it onto the 

frame. First, the clear size of the frame is measured with 3 clicks. The first click must be on an 

anchor in the corner of a profile or at the end of a groove. The two following clicks are used to 

define the length, width and orientation. Only rotations in 90° increments are possible to align 

the first anchor. It is also possible to snap to anchors to define the length and width. Both are 

similar to definition of the rotation and length using the mouse in simple Insert mode. Here it is 

also possible to "fix" the rotation by keeping the Ctrl key pressed and only change the distance. 

After defining the base area in this way, 

various insertion scenarios are offered for 

you to choose from, which are possible for 

the selected area part. Here it also makes a 

difference whether you select a point in the 

profile corner as the start point (supported 

insertion) or at the end of the groove 

(internal insertion). After you have decided 

which scenario to use, you may be asked on 

which grooves the fasteners are to be 

positioned (only for supported insertion). 

This selection is ended by pressing the "Next" button or by clicking the background in the Main 

window which there are no anchors. 

 In the final step a preview of the area part is displayed with its fasteners. The dimensions and 

height offsets predefined by the fasteners have already been applied to the area. It is now still 

possible to adjust the edges by dragging them with the mouse or by entering relevant values in 

the Control window. There you can also switch off the fastener (and any associated dimension) 

for individual edges of the area or check the distance of fasteners. You can also rotate the area 

together with the fasteners. 

It must be noted that when you adjust the edges in the last step, in case of internal insertion the 

fasteners are moved too, but in the case of supported insertion they remain on the selected 

grooves. 

4.7 DELETE  
This function is used to remove already positioned instances. If one or several parts are 

already selected  (marked) when the mode is activated, these are removed and the mode is 

then ended automatically. However, if no part is selected on activation the mode remains 

active until it is cancelled. Parts are then removed by simply clicking them. 

4.8 REPLACE  
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Replace mode enables one or several parts that have already been installed to be replaced by 

other articles. The positioning and rotation are retained. To this end, in the Main window the 

parts to be replaced are selected first  (multiple selection possible in the same way as for 

"Select"). Then (as long as the mode remains active), whenever a new article is selected in the 

Library list, these selected parts are replaced by the new article. 

4.9 COPY  
This can be used to duplicate one or several selected parts. A new position is then defined for 

the new inserted copy. The behavior is identical to the Move mode described below (see 

below) with the only difference that to create the copy you do not have to press the Ctrl key. 

The same effect can also be achieved without this mode by copying the parts onto the internal 

clipboard with Ctrl C (or move them with Ctrl X) and then pasting them with Ctrl V 

(alternatively using the corresponding menu entries). 
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5 EDITING MODES 

5.1 MOVE  
This mode is used to move one or several parts already placed freely in the space without 

changing their rotation. If not parts to be moved have been selected yet, the command begins 

with a "Select Part" action. The mouse can then be used to define and axis and distance. 

Direct entry of a numerical value in the Main window enables precise offsetting on the last 

axis selected in this way (mouse is deactivated). Alternatively, it is possible to changeover the 

mouse control in the Control window, so that the movement is made on a specific axis or plane 

(direct entry of the distance is then not possible). The increment of the mouse offset can be set 

in the Control window.  

The Space bar allows you to switch between the global coordinate system and the coordinate 

system of the part to be moved  (in case of multiple selection the reference part applies, which 

is shown in a different color). 

 As an alternative to mouse control, it is also again possible to enter the numerical values in 

the Control window. To do this you can use the Backspace key to deactivate the mouse control 

(unless you are in the middle of making a direct entry, in which case the key is used to undo the 

entry). The Cursor keys and the Page Up /Down keys also enable you to move using the 

keyboard. If, while confirming the move by clicking the mouse or Enter key, you also press the 

Ctrl key, the part is copied instead of moved (see Copy mode) 

5.2 MOVE VIA ANCHOR  
While the Move mode described above works independently of anchors, this alternative mode 

concentrates on their use as an orientation aid. After the parts to be moved have been selected, 

this command begins by selecting a start point followed by the selection of an end point. Both 

points are any anchors in the assembly, where if line anchors are selected the precise position 

can be defined with the help of the Control window. The selected parts are then moved so that 

the start and end point are congruent, i.e. along the vector, which connects the two points. 

None of the anchors have to belong to the moved parts, you can therefore "pick off" the vector 

anywhere. You can also use the Control window to block individual coordinate axes, so that no 

movement or offset takes place on this axis (only along the unblocked axes). If, while selecting 

the end point, you also press and keep pressed the Ctrl key, the part is copied instead of 

moved. 

 

5.3 ROTATE  
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You can use this command to subsequently rotate an already positioned part (or even several 

parts). After selecting the part, you first select the centre of rotation in the form of any anchor 

in the scene. It is also possible to switch off the mouse control and instead to enter any world 

position in the Control window. The next action is used to select the axis of rotation. Here 

the Space bar enables you to switch between the axes of the global system and those of the 

local coordinate system. After the point and axis have been defined, the mouse can be used to 

define the rotation. As usual the Space bar continues to switch between global and local, while 

the Cursor and Page Up/Down keys can be used to rotate about all 3 axes. The Control 

window again enables direct input of numerical values and subsequent changing of the axes 

for the mouse rotation as well as the increment. If, while confirming, you also press and keep 

pressed the Ctrl key, the part is not only rotated but is also copied. 

5.4 EDIT LENGTH (SCALE)  
In the case of the parts for which this is allowed, this function can be used to subsequently 

change the length (possibly the width and thickness too). To do this, first select the part 

concerned and then define the fixed point. This is an anchor of the selected part, which is to 

remain in its position when the length is changed. The following lengthening or shortening 

takes place accordingly at the opposite end. The change can be defined with the help of the 

mouse or by using the Page Up /Dow keys or by entering values in the Control window. 

Also, as with inserting parts, it is also possible to enter the length directly in the Main 

window (Backspace resets the value). Also analogous to Insert, it is possible to automatically 

adjust the length up to an anchor. This is in turn done by pausing with the mouse pointer on 

the anchor concerned. 

In case of area parts with variable length and width, with the mouse control the area is 

stretched between the fixed point and the mouse position (as the orientation is already 

defined, 2 points are sufficient to define the area). Here too, the program automatically jumps to 

anchor points. Direct input of values (in the Main window) is not possible for area parts. 

5.5 RESIZE  
This mode is an alternative to the "Edit Length" (Scale) function described above. Also, like 

there, here an already positioned part with variable length and possibly width / thickness is 

post-processed. However, this mode follows a different approach, which is not based on 

selecting a fixed point. Instead, directly after selecting the part to be edited, it is possible to 

move the ends or the edges by means of Drag & Drop (important: you must click the centre 

of the side marked in color, not in the Preview box). Alternatively, the modifications can also be 

entered in the Control window (analogous to Insert mode for area parts). There it is also 

possible to define the increment for the mouse control and to define whether or not this 

should jump to anchors. In the case of area parts, the part can also be rotated there (thickness 

then stretches in the opposite direction) and if applicable enter the thickness. 
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It is also possible to apply this mode to a multiple selection of parts. However, only the parts 

which can be scaled parallel to the reference part (identifiable by their color) can be edited. 

Regardless of the position of the parts, the same length is added or deducted at the same end of 

each part. 

5.6 DRAG & DROP  
This function can be used to move already positioned parts by means of Drag & Drop. To do 

this, the part to be moved is picked / clicked at its anchor and with the mouse key pressed it 

is dragged to another anchor of the assembly. When the button is released the part is 

inserted in the new position with its old orientation (and if applicable the same length). 

Before finally confirming the action it is still possible to adjust the orientation and length if 

required. The behavior is identical to placing a new part. If, while releasing the mouse button, 

you also press and keep pressed the Ctrl key, the part is copied instead of moved. 



 

www.cadclick.de - 22 - © KiM GmbH 

6 NOTES, POSITION NUMBERS AND DIMENSIONS 

6.1 MEASURE  
This function can be used to measure the distance between two anchors in the assembly. To do 

this, the start point is selected first. Then move the mouse over the other anchors to display 

the distance from the start point to the relevant anchor. In the case of line anchors, it is again 

possible to define the precise position of the start and end point with the help of the Control 

window. If an end point is selected the measured distance is copied onto the clipboard and the 

measuring procedure is restarted 

6.2 DIMENSIONS  
While "Measure" mode is merely used to check distances, this mode generates dimensional 

information, which remains in the 3D view of the Main window. In order to position a new 

dimensions, you must first click the start point and then the target point (anchor). You can 

use the Control window to select whether the geometry of the parts is clicked directly or 

whether the anchors are used. A special feature arises if a line anchor is clicked and the mode 

is activated for automatic dimensioning. In this case the line anchors cannot be used as end 

points, but if they are selected as the start point they automatically generate a dimension which 

accepts the start and end point of the anchor. Another click sets the dimension text. 

Whenever this mode is active, already positioned dimensions can also be moved again by 

picking and dragging them. As in the last step of inserting, the text is moved but the 

measured length is not changed. The dimension is moved, but its ends are connected to the 

measured points by additional lines. 

If a dimension has been selected by clicking on it, the text can be changed using the keyboard 

or it can be deleted using the Del key. Selecting the dimension also causes the color and size 

to be set as in the Control window. Other setting options only affect dimensions generated in the 

future. This concerns both the number of places after the decimal point and restriction to 

axes or planes. 

If a dimension is limited to an axis or plane, only the distance along this 

axis or plane is measured. Help lines (extension lines) can be attached to 

clearly illustrate the distance that has been measured and to connect the 

clicked end points. It is possible to choose whether the points are directly 

connected with each other ("diagonal") or whether the "help lines" are to be 

broken down into components parallel to the axes. In the case of the latter 

variant, a decision is also made whether only one of the components is to be 

displayed and the order in which the axes are to be worked through. 

Here is an example of the help lines for a dimension on the Z axis, viewed from above: 
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Limiting to axes and planes also affects the moving or offsetting of dimensions. If such a 

restriction is active, the movement does not take place on the screen but on the plane 

corresponding to the restriction. Where this plane is viewed with too small an angle (<30°), the 

anchor is adjusted to prevent moves to extreme distances. 

Apart from limiting to axes and planes, it is also possible to limit orthogonally. In this mode, the 

measurement and movement is always made along one of the 3 axes. In the case of 

measuring, the axis along which the distance between the start and end point is the largest 

is always chosen, while it is then possible to move along the two other axes. 

In the Control window, the "Update All" button can be used to transfer to current setting for size 

and color to all existing dimensions. 

The "View" menu ( ) can be used to temporarily hide all dimensions without deleting them. 

6.3 POSITION (ITEM) NUMBERS / NOTES   
You can use this mode to attach notes to already installed parts, which can then be seen in the 

Main window. A note is also inserted by clicking on the part in the place where the note is to be 

attached. The text can then be freely positioned within the 3D space, while it always remains 

connected with the original click position by a line. The movement takes place on the screen 

level, the view therefore plays a decisive role for the position. With another click, the text is 

placed in the mouse position. Notes that have already been placed can be moved again at any 

time, provided Note mode is still active, by picking and dragging the text with the mouse. 

Click another note to select it; its text can then be changed using the keyboard. Press the Del 

key to delete a selected note. The size and color of future notes can be set in the Control 

window. It is also possible to select the shape of the surround. These settings are applied to 

existing notes when they are clicked. However, the "Update All" button can be used to quickly 

transfer them to all notes. 

The default text selected for new notes corresponds to the current position (item) number 

of the corresponding part in the bill of quantities. If a position number is to be assigned to all 

parts, it is not necessary to create a note for each individual part. The control window provides 

several algorithms, which automatically insert an appropriate note for each part that can 
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be currently seen and position the text in the space. A distance factor can be given, which 

affects the distance of the text from the part or more precisely the length of the connecting 

line. It is also possible to choose whether the middle point (centre) of the scene or the average of 

the centers of the individual part (called the centre of gravity here) is used as the origin of the 

algorithms. Another option "visible only" defines that only parts whose centre is not concealed 

by another part are assigned position numbers. 

The various algorithms used are briefly explained in the following: 

 Sphere: From the centre of each part, the text is moved away from the origin so that the 

distance from the origin is the same for each text, i.e. all are located on the surface of a 

sphere. 

 Explode: From the centre of each part, the text is moved away from the origin and the 

further it is moved the greater the distance of the centre to the origin. 

 Expand: The common feature of all 4 variants of this algorithm is that the length of the 

connecting line is the same for each note inserted. Unlike Sphere and Explode, the 

movement is no longer straight from the origin, but depending on the variant is adjusted 

by different amounts: 

o 1: From the origin, however with a correction factor, which takes into account the 

different extent of expansion of the scene along the 3 dimensions 

o 2: From the origin, however each dimension is cubic-attenuated, so that the 

direction is no longer along the axes 

o 3: From the origin, however adjusted to 45° angle relative to the axes 

o 4: From the origin, however adjusted to the axes 

The notes positioned by these algorithms can be subsequently adjusted, moved and deleted just 

like any other note. On the other hand, it must also be noted that after they have been inserted, 

they are normal notes whose contents are not automatically adjusted if changes are made in 

the bill of materials which affect the position numbers. To update the note to the current status 

of the bill of materials, you can either press the Pos1 key (affects the currently selected note) or 

the "Refresh" button in the Control window (affects all automatically inserted notes). 

Instead of the position (item) number, other information can be inserted from the bill of 

material. To do this, the required information is selected in the Control window (apart from the 

position (item) number, it is also possible to select the Article No., Name/Description, 

Dimensions and Size). As, if a multiple selection is made, the different entries are placed 

consecutively, here it is also possible to define a text that is used as a separator. 

The "View" menu ( ) can be used to temporarily hide all notes without deleting them. 



 

www.cadclick.de - 25 - © KiM GmbH 

7 SIMPLE INTERACTION VIA HANDLES 

7.1 EDITING SELECTED PARTS 
If already installed parts are to be edited, depending on the type of editing 

(move, rotate, etc.), this can be done in great detail using the respective 

matching editing mode described above. However, there is an alternative 

that allows quick editing without having to change mode. To use this, in 

"Select" mode (if the corresponding option has been activated in the 

Control window), handles are shown on the selected part, which can be 

dragged by pressing the mouse button. 

The color of the handles symbolizes the editing to be carried out as follows: 

 Yellow – Rotation: The selected parts are rotated about the 

displayed axis and the centre of rotation corresponds to the centre 

of the handle. 

 Orange – Offset: The selected parts are moved along the axis 

displayed by the handle.  

 Violet – Resize: The size of the selected parts, if possible, is 

changed in the direction displayed by the handle, and the same 

length is added to or deducted from each part. 

All these edit functions are also possible if several parts are selected. 

However, in this case, it can be decisive which part is selected as the primary part. This part, also 

identified by the marking color, contains the handles and acts as the reference for the editing of 

all the selected parts. Therefore, depending on the primary part, the axes and centers of rotation 

available for selection can also change. If a multiple selection has been made (by holding the 

Control button and /or dragging a frame), the part nearest the mouse pointer becomes the 

reference part. This change in reference part can be prevented if necessary by pressing the Ctrl 

key and keeping it pressed, in order to reach the required handles with the mouse pointer. 

As with the special editing modes, a copy can also be made when moving and rotating by means 

of the handle by keeping the Control button pressed. In addition, in the Control window (or the 

"m" and "s" keys) it is possible to define whether or not anchors are to be used as the target for a 

move or size change. Here it is also possible to select the increment for the editing. Another 

option activates automatic hiding of handles if they are too close to each other due to the 

viewing angle and zoom. 

The handles cannot only be dragged, but also allow the required numerical values for rotation, 

movement (offset) and size change to be defined directly. To do this, the value must be entered 

using the keyboard while the mouse pointer pauses over the relevant handle. If the entry has 
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been started, the Enter key can be used to make the change or it can be cancelled by pressing the 

Escape key. Alternatively, buttons are also available in the Main window, with which you can 

confirm or cancel. 

7.2 COMPLEX EDITING THROUGH SIZE CHANGES 
In the case of size changes, the handles can be used to achieve effects not possible even with the 

special modes (in a single step). Here it is decisive to note that the size is only changed for the 

parts that allow a change in the chosen direction. Unlike "Resize" mode, however, the other parts 

are not ignored here but are moved according to the size change. By skilled selection of the 

marked parts it is possible to make complex changes in a single step. The following example of a 

workbench is used to illustrate this: 

 

Here the width of the workbench was increased first and then its depth. This was done with a 

single interaction with the selected (violet) handle for size change. It should be noted that both 

the tabletop and the profiles which were scalable in the chosen direction were lengthened, while 

unchangeable parts (such as feet and cover caps) as well as profiles located perpendicular to the 

direction were all moved by the same amount. For each of the two actions, other parts had to be 

appropriately selected. In a comparable way it would also have been possible, e.g. to change the 

height or length of the cantilever in one step. 

7.3 INTERACTION WITH ANCHORS 
You can use the Control window or a corresponding button in the Main window to switch off the 

display of the handles. The anchors of the selected part are then displayed instead. In this case, 

however, the anchors are displayed in a violet color and provide special use options. 
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With a single click of the anchor (with the left-hand mouse button), the part currently selected in 

the library is installed in this position by means of the Quick Insert function. In this way, parts 

can be installed quickly without having to change to an Insert mode. 

If you right-click an anchor, instead of the usual context menu, in this case the program searches 

the library for all parts which could be logically installed in this position (see Parts Logic chapter 

later in the document). 

Apart from clicking the anchor, here it is also possible to pick the anchor and, with the mouse 

button pressed, to drag it to another anchor in the assembly. In this case the selected parts are 

moved so that the picked anchor and the target anchor are congruent. To access concealed 

anchors, you can keep the Shift key pressed to display the current part transparently. 
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8 MORE ABOUT THE WINDOWS 

8.1 SEARCH IN THE LIBRARY 
The toolbar of the Library list allows a text search optionally in the article numbers, 

descriptions and/or dimensional information of the parts. The search result acts as a filter. The 

active filtering can be identified by the marking in the toolbar (where the number of parts found 

is also displayed) and the background color of the list. It can also be removed. 

If you enter a search enquiry, the product group marking in the library tree switches to the main 

nodes to display that the search will be made in the entire library. It is also possible to limit the 

search to the product group presently active. To do this, before starting the search, the 

corresponding function must be activated in the toolbar , which prevents automatic 

cancellation of the group selection. 

Further, a search filter is cancelled as soon as the group in the tree is changed. This automatic 

behavior can also be prevented using the corresponding function to block the filter . 

The last column in the table enables a marking to be set for each product and therefore to define 

it as a favorite. You can use the window's toolbar  to activate a filter, which only displays the 

parts marked in this way. This filter corresponds to a search for marked parts and behaves 

analogous to a search filter. 

Another search function is based on the logic information, which defines whether or not parts 

can be installed together. The search for suitable parts  browses the library for all parts which, 

according to the parts logic, can be attached to the currently part. This search is also like the 

other search filters. The same also applies to the search for parts that can be installed in a 

specific position, which is initiated using the "Search for fitting parts" mode or by right-clicking 

an anchor in "Select" mode (see there or Parts Logic chapter later in the document).  
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8.2 ASSEMBLY MANAGEMENT INTHE PROJECT WINDOW 
 All part instances installed in the current assembly 

are listed in the Project window. The selection of an entry 

here marks the corresponding part in the Main window 

and vice versa. 

However, the actual purpose of the Project window is to 

group parts together in any way required. If you have 

used the "Select" mode to mark several parts in the Main 

window, it is sufficient to press the "Create Group"  

button  in the toolbar of the Project window to create a 

group with these parts. From now on you can Select the 

group entry in the Project window to make a 

corresponding multiple selection in the Main window. 

You can use Drag & Drop on entries in the tree to 

rearrange individual parts and whole groups. For example 

- by moving one group into another group - your can set up a hierarchy. Multiple selection by 

selecting a group entry always includes all parts in the group including all sub-groups. Groups 

that are no longer required can be disbanded  by pressing the relevant button. Their contents 

are then moved into the next higher group within the hierarchy. 

It should be noted that with grouping, a part can only ever be in one group. If you create a new 

group and use a part that is already in another group, it is moved from there into the new 

group. Otherwise, when you insert a new part in the Main window, it is possible that automatic 

grouping takes place. If an attachment is made to a part, which itself is in a group, the new part is 

automatically moved into this group (can be switched off in the options). Further automatic 

grouping takes place with Copy & Paste. If a multiple selection is inserted, the parts 

concerned are automatically grouped together in a new group. Area parts and fasteners are also 

grouped if the Insert Wizard for area parts is used. 

The grouping of parts not only helps to restore suitable multiple selections. The groups can also 

appear in the bill of materials described later in the document. As with individual parts, it is 

also possible to name groups. This is then also used in the bill of materials as the name of the 

group. 

Another function results from the Lock icon  of the groups, which can be clicked to close it or 

open it. If a part belonging to a group with active lock  is selected in the Main window, all other 

parts in this group (and its subgroups) are also selected. 
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8.3 THE BILL OF MATERIAL (BOM) 
The bill of materials always lists the individual parts currently used in the assembly. The 

article number and the information taken from the data about the name and dimensions are 

also displayed. In the case of parts with changeable length, the used length is also given (or the 

length and width of area parts). Where parts are used repeatedly in the identical way (i.e. 

with the same sub parts, size details, etc.), instead of a separate entry for each part, the number 

of parts is given in the corresponding entry. If a listed article is a discontinued item, a 

corresponding warning is 

displayed . If you click an entry 

the corresponding elements are 

marked in the Main window. 

 The bill of materials has a 

hierarchical layout (hierarchy 

levels are expanded by clicking 

the + Symbol) which can also be identified by the issue of position (item) numbers. For 

example, a connector assigned to a part is given as sub-items (sub-positions) in the entry of 

the part. If configurations are used (see below) the parts from which the configuration is made 

(if known) are also included as sub-items. In addition, the group hierarchy defined in the 

Project window is also displayed in the bill of materials. The toolbar of the Bill of Materials 

window can also be used to place the bill of materials in an alternative mode in which the 

group hierarchy of the Project window is ignored.  In this mode it is also possible to drag 

individual columns (represented by their header entry) to a correspondingly marked bar and in 

this way to group the listing by the entries of the corresponding column. In both modes you can 

also change the order of the columns by dragging or sort the list by column entries by 

clicking the header entry. 

The bill of materials also has an alternative 

display mode in the form of an order list. Here 

the editing of the corresponding parts is left as 

it is, but the attached parts, for example 

screws, are listed at the end of the list as 

separate items. 

If a price list is available, a price calculation is also performed in additional columns of the 

bill of materials and a total sum is given. It is also possible to load the price list via the toolbar  

 or to unload it . When the program is closed and restarted, the last used list is automatically 

reloaded. 

The bill of materials can be output in different file formats or be sent directly to a printer. It is 

also included in exported PDF documents (see below). 
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9 IMPORT / EXPORT 

9.1 CAD EXPORT  
If you open the "CAD Export" function you can reconstruct the entire assembly with CAD data 

and export it in a large number of 2D and 3D formats. Following completion of the 

reconstruction, you can use the relevant dialog to select the required 2D and 3D formats and to 

perform the export. Here it is also possible to calculate and display a preview of the 3D or 2D 

exports. If a 3D preview has been calculated, the viewing angle in the relevant window is used 

for the calculation of the 2D derivation, otherwise it is based on a default view which can be 

selected using the Combobox. 

An almost identical function is 

provided by the "CAD Export 

(selected)" function. The only 

difference here is that in this case only 

the parts currently selected in the 

Main window are included in the 

reconstruction. 

It should be noted that the geometry of 

very large assemblies can become very complex. To counteract this, it is 

possible to adjust the degree of detail of the exported parts. This is defined 

using a switch in the Import/Export menu or the toolbar of the Library list.  

9.2 PDF EXPORT  
This function generates a PDF file, which contains a picture of the assembly and the bill of 

materials. The picture uses the current viewing angle of the Main window, however, the detail 

window is zoomed so that the entire assembly can be seen. The settings, which define whether 

position numbers, dimensions, floor grids, coordinate systems, etc. can be seen are also copied 

over. On the other hand, the background color and the interactive coordinate system in the 

bottom left-hand corner of the Main window are not copied into the export. 

9.3 STEP/SAT IMPORT  
You can use this function to import a Step or Sat file and to include it in the library as a new part. 

After selecting the file to be imported the article number, name and dimensional information are 

specified. The new article is then available in the Library list under the "step/sat" group. Step or 

Sat files that are no longer required can be removed from the library using "OptionsCache 

Overview". 

After the import, parts imported in this way can be installed just like any other parts. If you save 

an assembly that contains such parts, the corresponding files are automatically appended to the 

Assembler file. However, it should be noted that for licensing reasons, the Step and Sat parts 



 

www.cadclick.de - 32 - © KiM GmbH 

must be omitted in a CAD export. Equally, they cannot be individually exported via the Library 

list. 

9.4 2D DXF IMPORT  
You can use this function to open a 2D Dxf file and use it as a floor slab. The display of such a 

floor slab can be switched on and off using "Display 2D dxf". It is also possible to unload the file. 

Otherwise a Dxf floor slab behaves similar to a floor slab based on the grid, i.e. it can be moved 

and rotated, but not copied or removed. The elements contained in the file are not only visually 

displayed but also have anchors. These are usually line anchors, but point anchors are also 

assigned, for example to the centers of circles. 

9.5 THE "INSERT FROM FILE" FUNCTION  
Use this function to insert an Assembler document into another document. To do this, the 

function is opened in the current document and the document to be inserted is defined. All parts 

contained in the document to be inserted are then inserted into the current document in a new 

group. The group structure of the inserted parts is retained. Here you should note that this 

involves a one-off transfer of the parts from one document into another and not referencing. 

Subsequent changes to the inserted file are not copied into the files into which it was inserted. 
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10 ADVANCED TOPICS 

10.1 SUB PARTS  
It is possible to assign sub-parts to a part in the assembly by dragging the relevant article from 

the Library list by means of Drag&Drop and dropping it onto the entry of the part in the Project 

window. There you can recognize parts with attached sub-parts by the small +symbol  

inserted in the icon of their entry. The selected sub-parts cannot be seen in the assembly, 

however, they do appear with the corresponding part in the bill of materials. 

Sub parts are often connectors. The 

"SubParts Setup" function therefore 

provides an alternative option for 

assigning connectors to one or several 

selected parts in the assembly. The 

connectors are inserted or removed 

here using a separate dialog. The part 

to which the connectors are assigned is 

displayed in the middle. Below it, on the 

left-hand side you can see a list of all 

possible connectors and on the right-

hand side those that have already 

been inserted into the part. You can 

use the arrow buttons between these 

two lists to add or remove the respective selected connector. Whether possible dependencies 

are to be taken into account or not can be switched on and off using the corresponding option. 

Other sub parts (attached by Drag&Drop) can also be removed (but not added) using this dialog. 

Not all parts are intended to have connectors assigned to them. If this is not the case, when the 

function is opened, the dialog described above is not displayed and instead a variant that only 

allows sub parts to be displayed and removed is shown. 

For an improved overview, in the "Tools" menu you can use the appropriate function  to select 

all parts in the assembly that have one or several sub parts. 

10.2 CONNECTIONS 
As described above, it is possible to handle connectors by assigning them to the parts to be 

connected as a sub part. However, here the problem arises that the editing necessary for the 

connector are all assigned to a part when the dependencies are used, although in fact they have 

to be shared between the two parts involved. The connections represent an alternative option to 

distributing connectors, which solves this problem and also provides further advantages. 
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While parts are assembled in the Assembler, where possible, in the background the program 

tracks which parts are related where. To this end, connections are created, which have a specific 

position and link to the two parts connected by them. If one of these parts is edited, the 

connection is also moved accordingly or if applicable is removed. When parts are edited, new 

connections can also be created, e.g. if a profile is lengthened by so much that it touches another. 

Connections can normally not be seen, but are displayed as spheres as soon as the "Edit 

connections" function  is activated. If you move the mouse pointer over such a connection, the 

two connected parts are marked. By clicking a connection it is now possible to assign a 

connector to it. It may also be necessary to 

select the correct position. If this has been 

done the connection is no longer displayed in 

red but in green. If no possible connector is 

found the connection disappears. In this way, 

it is possible to directly trace which 

connections have already been processed and 

which have not been. Because the connector 

assigns a connection and is not attached to an individual part as a 

sub-part, connectors and necessary editing in the bill of materials are 

now suitably divided between the two parts concerned. In addition, the 

position of the connector can be traced. If activated in the options, the connector can usually also 

be seen in the assembly. 

It is possible that the automatic generation and adjustment of the connections does not 

correspond to the required result. Therefore, adjustments can be made. For example, while "Edit 

connection" mode is active you can delete connections by moving the mouse pointer over them 

and pressing the Remove button. You can also generate new connections. To do this, you must 

select at least two touching parts and then start the "Add Connection"  function. The selected 

parts then try to connect with each other in pairs. If several possible positions are found for a 

connection, they are displayed and you can choose the one required by clicking it. 

The "Set up all connections" function  enables the same connector to be assigned too many 

connections without having to select them individually. After selecting a connector, all 

connections not yet edited (i.e. red ones) are assigned to it (if possible there). Of course, the 

positions at which this connector was not wanted can then be post-processed. 

It should also be noted that the connectors assigned to connections do not count as sub parts. 

They therefore do not appear in the dialogs described in the relevant chapter, but are displayed 

in the bill of materials in the same way. 

10.3 CONFIGURABLE PARTS   
While most parts have a fixed geometry or at most their length can be changed, there are several 

which are freely configurable. These can be identified in the library window by the + in the 
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symbol . If such an entry is opened (for technical reasons a product group with only one 

entry), a dialog opens in which already created configurations can be selected and new 

ones can be created. If necessary, the dialog can also be opened again later using a button  in 

the toolbar of the Library list for the part selected there. 

The dialog for selecting a configuration lists all already created configurations stored in the 

cache together with a preview image.  You and then use the "View" button to again display 

the respective configuration for the entry just selected. If the selected configuration is not used 

in the current assembly, it can also be deleted from the cache here. On the other hand,  to 

create a new configuration, you either use the "New" or the "Edit" button. In both cases a 

window is opened where a new 

configuration can be created. The difference 

is that in the case of "New" the default 

configuration is used as the starting point, 

while in the case of "Edit" the same 

configuration as for the entry just selected is 

preset (despite this, a new configuration is 

created and the old one is retained). 

A 3D preview of the part can be seen in the 

Configuration window, which is usually 

updated as soon as a change is made to the configuration. To work more quickly it is also 

possible to deactivate the automatic update and to perform it manually when required. The 

preview always shows the lowest degree of detail, but the degree of detail for generating the 

part can be selected in the window. 

Analogous to the "SubParts setup" function, in the "Tools" menu there is also an "Edit 

Configuration" function, which is applied to a selected configurable part. The dialog for 

selecting a configuration then opens where the current configuration is marked. It is now 

possible to select an already created configuration or to create a new one in the familiar 

way (usually using the "Edit" button so that it is based on the current one). If the dialog is 

closed with "Apply", the part to be edited is replaced by the selected configuration. 

10.4 PARTS LOGIC 
Check logic restrictions (if the necessary information is available in the data) whether insert 

part and attachment can be installed together with the respective selected anchors. On the 

one hand, this is done on inserting a part, in that parts and anchors which cannot be 

attached cannot be selected. On the other hand, the "Search for fitting parts" function 

enables you to search for all parts which can be installed in the selected position. These are 

set as a filter in the Library list (comparable with a text search). There is a similar search in the 

toolbar of the Library list, where it is possible to filter out parts that fit the selected part. Also, 

any anchors that are not allowed are hidden in the Preview window and cannot be 

selected.  
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During the insertion it is possible to temporarily suppress the logic restrictions. This is done 

directly in the Main window using the corresponding button. In the options there is also a 

switch, with which the logic restrictions can also be switched off long-term. However, in this 

case you must note that these method of circumventing the restrictions do not work with all 

functions. For example, the Quick Insert mode is dependent on the logic information and 

therefore uses its regardless of the settings. However, if the logic is switched off in the options, 

detailed insert is used as a default, and can also do without this information. 

The logic information also enables automatic insertion of cover caps  and assembly brackets 

 using the corresponding functions in the "Tools" menu. Cover caps are inserted in all free 

ends, where you can choose whether this applies to all parts in the assembly or only to the 

selected ones. In the case of assembly brackets on the other hand you must select precisely two 

parts. An analysis is then performed of how these parts can be connected with angle brackets. If 

necessary, the required type of bracket is selected and a query is made for each possible 

insertion position, whether a bracket is to be inserted is not. 

The same logic information is also used in many other places, e.g. for automatic generation of 

connections. 

10.5 SAFEGUARD GUARDS  
The Minitec protection system SafeGuard offers standardized modules for installing guards. The 

relevant fields and posts can be set up especially fast and easily using the Wizard described here. 

Directly after starting the Wizard the user has the choice of whether or not to extend an already 

assembled post. If they decide not to the Wizard begins with selection and positioning of the first 

post, otherwise it skips this and goes directly to insertion of the first fields. The Wizard then 

switches between the insertion of fields and posts until it is ended using the corresponding 

button in the Main window or using the Esc key. 

INSERTING FIELDS: 

To insert fields it is first necessary to define which 

field is to be inserted. In the dialog box used for this it 

is possible to filter the selection list by material for the 

filling (infill) and type of field. In addition, the user 

also defines here which fastening kit is to be used to 

insert the field. (The fastening kit cannot be seen in 

the assembly but  is appended to the field as a sub part 

which then also appears in the bill of materials.) 

After selecting the field the user can then position it 

with the mouse. It is always attached to the nearest anchor of the preceding post. The insertion 

angle can be adjusted by the increment given in the Control window. However, it is also possible 
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to enter the required angle directly using the keyboard or in the Control window, where the 

value is given as a deviation from straight insertion. If the mouse pointer is moved far enough 

from the last positioned post, it is possible to insert several fields of the same type consecutively 

in a straight line with only one step. The necessary posts are also inserted at the same time. An 

offset is only necessary where the field to be inserted or the construction direction changes. 

Before an insert is confirmed using a left-click in the Main window or pressing the Enter key, 

several adjustment options are available, which can be accessed using the buttons in the Main 

window or using keyboard commands. For example, it is possible at any time to change the field 

to be inserted or the posts to be used for several fields (F/P key). It is also possible to skip the 

types of positioning of the posts (Tab key) or to rotate the fields, i.e. to swap the inside and 

outside (Space bar). 

If a door is chosen as the field to be inserted, several points of the insert behavior are modified. 

For example, only one door is ever inserted simultaneously and it is not possible to modify the 

insertion angle. In addition, the option for rotating the door is supplemented by a further switch, 

which defines the side towards which the door opens (Tab key). This is also visually clarified by 

additional extension lines. 

Like with other modes, the Control window can be used to switch off mouse control (Backspace 

key). In this case, in general only one field is inserted and a button in the Main window (or the 

Tab key) can be used to define the anchor of the last post to which the attachment is made. 

INSERTING POSTS 

The insertion of posts functions similar to the insertion of fields, however, with less options. 

Here the mouse can only be used to affect the insertion angle. Also, a button or the Tab key is 

used to skip the anchor of the post to be used. 

10.6 ASSEMBLIES 
With the help of assemblies it is possible to define assemblies created in Assembler as new parts 

which then appear in the library and can be installed just like other parts. It is also possible to 

dismantle installed assembly parts back into the component parts from which they were 

assembled. One example of such assemblies is the guards of the Wizard described above. These 

can be dismantled into their individual parts and then edited in order to obtain individual fields 

outside the SafeGuard standard. 

To create your own assembly, you must first assemble it in an Assembler document, just like 

with any other assembly. You must then select the "Create Assembly " function in the menu. 

This function creates an assembly from all the parts currently selected in the document. 

However, it is still decisive, which anchors the created assembly part should have. In general it 

does not make sense to apply all the anchors of the individual parts. Therefore, you must first 

select the anchors of the assembly, which are to appear later in the assembly part. Anchors can 

be selected and deselected however you wish until the selection is confirmed by pressing the 



 

www.cadclick.de - 38 - © KiM GmbH 

corresponding button in the Main window. You then enter the article number, name and 

dimensions of the assembly part, as it is to appear in the bill of materials when it is used. After 

you have finished creating the assembly the parts is then available in the "assemblies" group 

within the library and can be installed. You should note when you create the assembly the 

degree of detail selected in the Import/Export menu applies. The assembly part appears 

accordingly detailed within the program and export. 

An assembly can be exploded (dismantled) into its individual parts at any time. This is done after 

selecting the relevant part using the "Explode Assembly " menu function. The function is also 

available as a button in the Main window if the "Select" mode is active and one or several 

assembly parts are selected. 
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11 OPTIONS  
The "View" menu or the options menu in the top right-hand corner of the Assembler window can 

be used to display and edit several options in the Control window. These should now be 

briefly described in greater detail here (a description of the entry just selected is also always 

visible in the bottom of the Control window). The settings are retained when the program is 

closed and restarted. Therefore, you should note that it is also possible to use the Options menu 

to restore the original Options settings. 

11.1 GLOBAL OPTIONS 
 Logic Restrictions activates the checking of the parts logic described in the 

corresponding chapter above 

 Auto Grouping defines whether, when parts are inserted, they are automatically 

inserted into the group of the attachment and whether or not a group is automatically 

formed on inserting from the clipboard or using the Insert Wizard for area parts. 

 Auto Connector dialog, if the option is activated, automatically opens the dialog for 

editing the sub-parts after inserting a part (if relevant for the part) 

 Auto Zoom, if the option is activated, automatically performs an automatic "Zoom All" 

after inserting a part 

 Add Parts Separately, if the option is selected, automatically ends Insert mode after 

inserting a part 

 Selection Proximity defines how near an object the mouse must be in order to select it 

 Anchor Size is a scaling factor for the display of the anchors and handles 

11.1.1 VIEW 
 Z Direction Upright affects the behavior on rotating the view with the middle mouse 

button pressed down. If active, the Z axis is always perpendicular and points upwards, 

i.e. the view cannot be "tilted to the side". This simplifies orientation in space. 

  Invert Transmission inverts the behavior of the Shift key if it is used to display parts 

transparently (the display is then transparent as long as the key is not kept pressed) 

 Transparency Mode defines how the parts preview is displayed, e.g. on inserting or 

moving. This setting has a large effect on performance 

 Anti Alias activates anti-aliasing (edge smoothing) for improved display quality 

 Background Top / Bottom changes the two colors which as color blending form the 

background of the Main window 
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11.1.2  RIGHT CLICK BEHAVIOUR 
This refers to activation of the alternative control method described below in the Gesture 

Control chapter. If applicable, here it is possible to switch between larger and smaller display of 

the Gesture menu (and therefore the gestures themselves). 

11.1.3 PRINT 
Several options are available here for printing out the geometry displayed in the Main 

window, which affect the image to be output: 

 Use Paper Format adjusts the section of the image to the paper format. If not activated 

the side ratio of the Main window is used, as can be seen on the screen. 

 Adjust to paper size adjusts the size of the printout with the same side ratio so that the 

sheet is filled. 

 Size Factor is a factor for the size of the printout on the paper. Values from 0.1 to 1 are 

allowed, where 1 corresponds to the full size. 

 Zoom All zooms out, with the same viewing angle, so that everything can be seen 

(corresponds to the "Zoom All" function in the Main window). 

11.2 DOCUMENT OPTIONS 
Here you can make several settings, which concern the currently active document. This includes 

a perspective display as well as an alternative View mode based on edges instead of filled 

geometry. An alternative lighting method (Phong) is also available. 

The Display Features option determines whether or not the editing and connectors assigned to 

the connections are displayed in the assembly (see chapter on connections). Waiving this display 

improves performance. 

11.2.1 GRID 
Here it is possible to configure the auxiliary grid and therefore the floor slab based on it by 

giving both the size of the individual cells and their number. Alternatively, it is also possible to 

give the total size of the grid, in which case the size of the individual cells is then adjusted 

accordingly, while their number remains the same. All details can be given separately for the X 

and the axis. Here it is also possible to choose between two variants, how the grid is to be 

positioned within the global coordinate system: The coordinate origin is either located centered 

in the middle of the grid (in which case the number of cells must be even) or in one of the 

corners (the grid then extends along the positive coordinate axes). 

11.2.2 3D COORDINATE SYSTEM 
This can be used to replace the coordinate system of the Main window represented by lines 

with an alternative display whose axis length can be freely selected. The positive axes then 

each have the full length and the negative axes 1/10 of the given length.  



 

www.cadclick.de - 41 - © KiM GmbH 

12 MISCELLANEOUS 

12.1 GESTURE CONTROL 
 If activated, gesture control replaces the Context menu and 

therefore the function of the right-hand mouse button. As 

long as the button is pressed the gesture control shows a 

circular menu, on which there are submenus (represented by 

"…") and possible commands. The selection is made not by 

clicking the icons but by moving the mouse in the 

corresponding direction. The advantage of this control option 

is that a user who has remembered the arrangement of the 

symbols can select the functions very quickly without having to search long for them. The 

selection is made via a specific movement pattern of the mouse or in other words with a 

gesture made with the mouse. For example, it is possible to quickly note that moving the 

mouse to the right and the left and up opens Insert mode while moving it to the right and then to 

the left and down deletes a part. By moving to the right and downwards it is possible to 

reactivate the last used mode. Operation via gestures takes getting used to but is then very 

effective.  

12.2 PROJECT INFORMATION 
Additional information about the relevant project can be appended in the files in which the 

Assembler saves an assembly. The input and display of these values, e.g. invoice and delivery 

address, e-mail, phone number or customer number, are made using a dialog opened using the 

"Project Information" function.  

12.3 GIMMICKS 
Several other functions are available via the "View" toolbar, which are used to display 

the assembly. On the one hand, this is the option of showing a sectional plane. Its 

position and rotation can be influenced by dragging the displayed arrows. 

 It is also possible to animate the displayed scene. A walk through (camera 

movement) around the scene is available for this, as well as a type of "Explosion" in 

which all parts can be moved away from the zero point of the global coordinate system. 

 

 

 

12.4 TIPS 

12.4.1 SELECTING THE RIGHT ATTACHMENT 
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As, depending on the view, parts can often conceal each other, when selecting an anchor it can be 

difficult to mark the required part in order to see its anchor. Therefore, the system for selecting 

the marked part is briefly explained here. Depending on the current action, there are two 

different methods for making the selection. 

With the first method, e.g. used for the selection of the attachment anchor in "Insert" mode, the 

marked part remains active until the mouse pointer leaves it. This is the case even if there is 

another part in front of it in the current view. If you want to mark the front part you therefore 

have to move the mouse pointer so that it no longer points to the already marked part. 

Alternatively, you can also press the Pos1 key to return to the previous action (in this case the 

part selection) and therefore automatically mark the front part. (By contrast, the Esc key would 

usually end the mode). 

The other method is used if an anchor is selected which does not have to belong to the marked 

part, for example, if the centre is selected in Rotation mode. Here the program always switches 

to the front part, even if the mouse pointer is still on the rear part. To prevent this you must keep 

the Shift key pressed. 

12.4.2 SELECTING THE RIGHT ROTATION 
For many parts the right insertion situation is sufficiently clear, so that the suggested rotation 

can usually be accepted. However, if it is necessary to adjust the alignment, due to the 

combination of mouse movement and pressing the Tab key, achieving the required rotation can 

be problematic. To simplify this, you should always be aware that when the Tab key is pressed 

the rotation is always  about the axis nearest the position of the mouse pointer. In the part to be 

inserted, this corresponds to the direction of the selected anchor. To return to the suggested 

orientation, you must position the mouse pointer on the axis that runs along the anchor on 

which you attached the part (the anchors are then once again aligned tip to tip). 


